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Thanks for reading ATPM.
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About This Particular Macintosh has been free since 1995, and we intend to keep it that
way. Our editors and staff are volunteers with real jobs who believe in the Macintosh way
of computing. We don’t make a profit, nor do we plan to. Our aim is to produce a fiercely
independent magazine, with multiple formats designed for easy reading rather than showing
ads. The views expressed in these pages have always been our own, and to help prove it we
do not accept direct sponsorships or advertising. We do, however, need to pay for our Web
site and other expenses, so we rely on minimal advertising, sold indirectly via Google and
Yahoo, as well as the support of ATPM readers who shop using our links.

)
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Welcome

by Robert Paul Leitao, rleitao@atpm.com

Welcome to the February issue of About This Particular Macintosh! This month has a leap
year extra day. The leap year is an interesting thing. It was first adopted in the Julian
calendar to reconcile the earth’s not-quite 365-day orbit of the sun with the seasons. With-
out it our 12-month calendar would drift along in time, and eventually we’d be celebrating
seasonal things at not so seasonal times.

That brings us to Aloysius Lilius, a 16th century man of learning (astronomy among his
disciplines) who determined that the Julian adjustments were a not-quite solution to the
calendaring of the earth’s not-quite 365-day orbit of the sun. Dr. Lilius has a lunar crater
named after him. I suppose it’s consolation for the calendar changes he advocated being
named after Gregory XIII, who incorporated the astronomer’s adjustments into Christen-
dom’s day counting for what is now called the Gregorian calendar. Dr. Lilius removed a
number of leap years from each millennium. It may seem like a subtle change, but over
time it makes a difference.

The editors of ATPM don’t expect to have a lunar crater named after us, but we do pay
close attention to happenings in the not quite perfect computing world. This month we’ll
delve into some of the lunacy that took hold in January, as Apple appeared to change its
own product orbit. Please read each of our issues carefully. Often times what we say on
our pages may seem subtle, but our work will make a difference in your personal computing
experience.

The Case of Missing iPhones

At the center of the Mac enthusiast orbit is each January’s Macworld Conference and Expo.
It’s a gathering place for developers, peripheral vendors, industry executives, and enthralled
Mac users who make a pilgrimage of the annual event.

During the keynote address, Apple’s CEO Steve Jobs announced that four million iPhones
had been sold since the product was first released in the United States on June 29, 2007.
Four million iPhones are significantly more phones than the number of iPhones that have
been activated by Apple’s authorized iPhone service partners. For at least a few moments,
the Apple orbit seemed to gyrate around these numbers. Absent service partners in much
of the world, using iPhones on non-Apple authorized services has become the rage. While
thousands of “missing” iPhones are no doubt in inventory, hundreds of thousands of these
phones are in the happy hands of users in many different places around the world.

The Case of the Missing Earnings

On January 22nd, Apple announced that net profits jumped 57% compared to the year-
earlier December quarter. iPod revenue leaped 17% on a 5% growth in unit sales. Apple
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shipped 2.319 million Macs during the Christmas quarter, 2.315 million iPhones, and rev-
enue leaped to an astounding $9.6 billion dollars. Cash flow added $2.7 billion to the
company’s bulging cash coffers. For the quarter Apple announced earnings of $1.78 per
share.

But it became the case of the “missing earnings.” At the bottom of the press release
announcing the astronomical growth in revenue and profits, Apple’s forward guidance for
the March quarter brought things decidedly back to earth. Apple announced guidance for
the March quarter to be revenue of $6.8 billion and net income of $0.84 per share.

This news sent Wall Street analysts into their own wobbly orbit. Apple’s public guidance
was below their expectations. Apple’s share price moved south and ended January trading
at $135.36 per share. The shares opened January trading at $199.08.

It’s taken a little while, but a few observers of Apple’s results realized the iPhone’s revenue
and earnings are missing from both the December quarter’s results and the March quar-
ter’s guidance. Apple is recognizing the iPhone’s revenue and manufacturing costs over 24
months from each iPhone’s sale. That means the net profits from each iPhone sold will
be recognized over two years, and only a fraction of that net profit will be reported in the
quarter in which it was sold. However, non-manufacturing costs for the iPhone division will
be fully recognized in the quarter they are incurred.

This means more costs relative to reported revenue now and more profit relative to reported
revenue later. Just to note it was a full moon the day Apple announced its earnings and
guidance. There are no missing earnings. The earnings will be found and reported on a
quarterly schedule that includes many moons for now.

Defying Gravity

The MacBook Air is so small you’d think it might hover in place. It’s the smallest and
lightest Macintosh ever made. It’s designed for the Internet age and lightweight travel.
Absent an enclosed media drive and an easily user-accessible battery, and despite its small
size, it sets a new standard for laptop functionality with a multi-touch trackpad. While
it might also lighten the pockets of buyers at its introductory price, we expect the new
touchpad to find its way into other Macintosh product lines. In other words, we expect
multi-touch functionality to create a product orbit of its own.

Our February issue includes:

Bloggable: Just Indulge Me

After weighing in on his own hits and misses for 2007, Wes Meltzer samples the blogosphere
for thoughts about the new MacBook Air, then wraps up with a few additional observations
on other topics.

MacMuser: One Click of My Finger
Mark Tennent weighs in about the Macworld keynote from the U.K.’s point of view.
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MacMuser: Transports of the Night
Leopard broke CyTV, and Mark Tennent is anxious for an update.

Apple Talk: Trade Show

When it comes to punditry about Apple, Angus Wong demonstrates how to sound like we
have a clue when we really don’t.

About This Particular Qutliner: A Progress Report
Ted Goranson sticks his head up from the foxhole and gives a progress report, some obser-
vations on Macworld Expo, and an opinion on outliner business models.

Photoshop For the Curious: Mask-erades
Want to make cutouts of objects in a photograph? Don’t risk erasing part of your image
and losing it. Use a mask, instead.

Segments: Macworld 2008 Keynote Impressions

Though he didn’t attend in person, Christopher Turner offers his impressions of Steve Jobs’s
keynote address to open the 2008 Macworld Expo, which took place in San Francisco last
month.

Desktop Pictures: Manado, Indonesia
Reader Kim Lee provides this month’s desktop pictures taken at resorts in Bunaken National
Park in Manado, Indonesia.

Review: Chameleon 5.0.881M Legacy

Great Photoshop plug-in for combining images painlessly, at a price, literally.

Review: Flip Words 2

This is a great combination of Boggle and Hangman, if you stick to the Classic version.

Review: Kinetik 15.4 Backpack

Not too pricey, not too big, and not too small, the Kinetik gets the Goldilocks Seal of
Approval for being Just Right.

Review: MacPinball 2.6

Ed Eubanks Jr. finds MacPinball to be a respectable implementation for computerized
pinball games, but no accolades for overall experience.

)
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A Cup of Coffee With That?

I don’t know what all the fuss is about over the e-book thing.

My wife and I have been reading books on our Palm Pilots for years now and wouldn’t have
it any other way.

The screen resolution is excellent, it’s easy to see and read, the pages change in the blink of
an eye, the search engine is excellent, there are a million books to choose from, the device
fits in one’s purse or pocket and is always at the ready in the doctor or dentist’s office, or
wherever else one ends up biding their time.

They are also great for reading in bed...no book-light required.

On that one little device we carry a number of books to choose from at any given time. We
never leave home without 'em.

What more could one want?
If you are looking for a solution to e-book reading, check it out.

—Stanley Jayne

Grandma'’s Life as a Video Star

What a great idea! If I have grandchildren, can you be our adopted grandmother? Your
directions are so explicit, perhaps that won’t be necessary. However, you have something
that can’t be found even in the iLife suite: lots of love. I’'m sure Steve Jobs is working on
putting that into iLife as we speak. He sure has made the greatest tools to share it, that’s
for sure. You are to be commended.

—Tim Jones

I did this for my niece and it worked great! I used the built-in iSight camera and microphone
on my MacBook Pro. For the DVD I found doing everything within the iDVD software
rather than using the Apple Disk Utility gave better results. I highly recommend the video
tutorials Apple has provided for the iLife '08 applications. Thank you so much for this
wonderful idea!

—Marcia Goetsch
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Fin Laptop Handle/Stand

I have to warn about using such products with MacBooks. Apparently because the iSight
was added to the bezel, the screens only fold back about 120 degrees. I have a long torso,
and the limited angle means that when my Macbook Pro is on my lap, the screen is at too
shallow an angle to my eyes. (An LCD screen has a limited viewing angle, so it becomes
hard to see.) It’s a major problem when I stand up (e.g. doing a presentation), and even a
marginal issue when the machine is on my desk.

Products like Fins-Up make the problem worse, by tilting both the keyboard and the screen
forward. It’s not their fault—it’s Apple’s poor design—but we have to live with the effects.
As far as I have noted, this problem happens with all portable Macs with built-in cameras.

—R Bohn

The inability of the AlBook and later Mac laptops to open past about 120 degrees has
nothing to do with the integrated iSight and everything to do with the redesigned screen
hinge. My AIBook, and all iBooks of similar design, has no integrated iSight at all, but is
still “cursed” with that hinge.

| say “cursed” in quotes because the previous hinge designs in Mac laptops had a lot
of problems which all seem to have been solved since Apple went to this new design. The
downside, of course, is that you can no longer open the laptop as far as you formerly
could.

If the screen becomes difficult to see when sitting on your desk because of a 1.5”
increase in the height of the screen, you are using a very ergonomically poor workspace
and probably have your computer far below where it should be relative to your eyes.
Furthermore, your comments would apply pretty much equally to all laptop stands ever
reviewed here at ATPM, as they all force a greater screen angle than simply setting the
laptop flat on a desk. Referencing my earlier comment about height, though, you should
probably look into something like an iCurve (or a taller desk).

—Chris Lawson

How Did | End Up Here?

Thanks. I have been a satisfied Sprint customer for six years. After being a voice-only
person, last week I purchased a Palm Centro (mini Treo), and find it very convenient and
easy to setup and use. Speed has never been an issue, Sprint is fast, very fast, and reliable.
I traveled to western Kansas this past weekend, and not one miss or hiccup in service or
speed.

You are correct, it (Palm/Sprint) gives me everything I need and want. . .and “it just works!”
Where have I heard that before?

—Rich Shields
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Funnily enough. ..l did exactly the same thing, recently! However, I went to eBay and
purchased myself a two-year-old Treo 650! (A cast-off from someone buying an iPhone, I
wonder!?)

I've been using Palms since a trusty Palm III many years ago (and graduated through
Handsprings and a Sony Clié NX70V); and, although my personal computer has always
been an Apple (starting with a Mac Plus, and now an iMac), I see no reason why my
handheld or my mobile needs to be the same brand (especially when I needed a very good
reason to combine my Motorola V3 and Clié—which the iPhone currently isn’t...).

Also: I've always found Palms to be exceptionally reliable; and the sheer amount of software
available (much of which I seem to have bought or tried over the years) is overwhelming—
and often lovingly crafted by developers who respond immediately to bug reports and
feature requests, etc. (even if the company itself is a little flaky ;-).

—Stephen Ward

[ agree with most points Mike raises. And I'm likely to make the same Treo 755p (not your
775p typo, Mike!) purchase despite my allegiances to Apple. My wife informed me that
she wants to get me a phone for my birthday this year to replace my Treo 600. My salivary
glands went into overdrive as I instantly imagined my very own iPhone in my hands. But,
then, reality set in.

First, we’re dedicated Verizon customers. Not because of our contract, but because we’ve
been treated decently by their customer service and the coverage everywhere we go is
excellent.

Second, when I was playing (note choice of word) with my sister’s iPhone last summer, I
also got the distinct sense that “serious productivity tool” was not a good descriptor for the
hot gadget, no matter how much its packaging and design appealed to me. I've tolerated the
heavy, bulky Treo 600 for years mainly because it’s a PDA /phone/QWERTY keyboarded
memo buddy. Prior to the Treo’s release, I had been one of those geeky jugglers of a PDA
and cell phone. Now I'm only a geek without the juggling. Only the phone function seemed
to be present in the iPhone (I couldn’t get comfortable with the iPhone’s touch screen
keypad—mno tactile feedback).

Third, I use Palm Desktop, and it has tons of my personal info that would take too much
time/effort to transfer to an iPhone-usable format. Even though I find Palm Desktop
laughable and pathetic (at least for the Mac), I still use it because it’s the most convenient
PDA-computer software I've been able to find (Palm, please update the Desktop for Mac!).

I've also dropped my Treo and done ridiculous things to it, and it looks almost like it
did when I purchased it some four years ago. I can’t imagine the highly chrome polished
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surface of the iPhone comfortably sustaining such abuse. And the profile of the iPhone—
while allowing its stunningly beautiful screen to shine—is too large for me to comfortably
carry around. Finally, I've got an iPod nano (3rd gen) that is in my pocket all the time, so
that relieves me from needing the iPhone music function.

I loved my 12" PowerBook, and I love my 15” MacBook Pro and my iPod Nano. But I just
couldn’t love an iPhone for what I'd need it to do for me. I still get excited when I see one
and hold one in my hands, but it’s just not the productivity tool my finite pocket space
requires.

—Michael Moon

Thanks for the interesting comments on the iPhone and Palm devices. I've owned and used
a number of phones and PDAs over the years and have a few observations, based on my
experience.

I'm currently an iPhone user. It isn’t a perfect device, and there are features it lacks that
I’d like to have, but I think it suits me for now. I gave up my BlackBerry for my iPhone,
and think it was a reasonable trade. I don’t send much e-mail from my phone, but I do
read my e-mail on my phone, so the iPhone works. I miss the BlackBerry keyboard, but I
don’t miss the hassle of synchronizing the BlackBerry and my Macs.

I started with a US Robotics PalmPilot many years ago and moved through a series of
PDAs and phones, searching for something “optimal” that conforms to my way of working.
Palm devices were stable and offered a reasonable software selection. When I switched to
Macs, they worked with my Macs. Windows-mobile devices were fun and capable, but
not stable—at least with the software suite I was using with them. Plus, after I switched,
persuading a Windows-mobile device to talk to a Mac was, um, challenging. Yeah, that’s
the word!

Ultimately, I decided I wanted to carry only one device. So, my PDA2008 went away and
I searched for a smartphone capable of helping me manage my life as well as talk. The
BlackBerry was a pretty good approximation. But, my frustration with synchronization
made it less than what [ wanted.

So, I bought iPhones for Wife and me. She’s happy as a clam. I can send and receive e-mail
from the variety of accounts I actively use. I don’t send a lot of e-mail, but I can if I need
to. I can track my calendar and do some minor Net surfing. The maps application is good,
and I appreciate access to stock quotes and weather.

The iPhone needs a task manager. It needs an integrated GPS receiver (and application).
With those two changes, I'd be happy.
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I gave up on Sprint after a nasty customer-service issue. This happened when I was looking
for a solution that ultimately led me to the BlackBerry. I got such a run-around that I
gave up in frustration, bought Wife and I out of our contracts, and switched carriers. Their
network was great; they dropped the ball on service.

—David Thompson

Tactile Pro
Ahhhhh!

I was hoping the Tactile Pro 2 was going to save me, but it sounds pretty flakey.

Both my white crumb-catcher Mac keyboards are wearing out, and I've been looking for a
decent keyboard for a over a year!

Why isn’t there a single well-made keyboard without a zillion extra buttons, gizmos, and
gimmicks?

Locally, T can’t even find any Mac compatibles. If 1 ask, salesmen say, “Apple’s new
keyboard is over here.” That thing is a pretty piece of design work, but an utterly unusable
piece of junk! I could type better on a $20 generic.

After reading this, I'm not buying a board I can’t examine in person.
What is going on with the keyboard market?

More and more, keyboards are adopting the worst aspects of the worst keyboards and
marketing them as if they’re some grand new innovations.

Flat with no contour; laptop style or chiclet keys; no indentation on key tops; no f & j
knobblies; no labels; mushy or spongy feel; flimsy plastic; undersized F keys; laptop-type
inline arrows; missing F keys, stupid splits and annoying wrist rests, built-in wheels, touch
pads, “specialized” keys, and LCD displays!

How about something that’s good for typing?!

I knew things were headed in bad directions when I first saw a keyboard in the local
CompUSA that looked and felt like a bad laptop keyboard and they wanted $124 for it!

Mice aren’t great either. Logitech is the only maker that does anything impressive, but
their Mac software and tech support are terrible!

—Scott

StudioBoard Mechanical Keyboard

I have now tried the Kensington StudioBoard, the Apple Extended Keyboard, and the
MicroConnectors keyboard.
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The Kensington StudioBoard and MicroConnectors keyboard are very close, in my opinion,
in action and sound. I would have kept my Kensington StudioBoard except for the L-shaped
return key. I ended up eBaying it, and found a MicroConnectors keyboard for much less
($1 plus shipping!) It’s a blueberry one, so it doesn’t look great (but is not so objectionable
considering its heritage and G3 iMac style—the black keys temper the fruitiness.) The
overall build quality is as good as the Kensington, so I am very happy with it. If I found
two or three at a garage sale for cheap, I would buy them all as backups.

The Apple Extended Keyboard is the best of all three, in my opinion. I haven’t seen an
Apple Extended Keyboard that isn’t yellowed by now, but as an old Mac user I like the
retro look (and retro build quality.) The key action is similar to the others, but the sound is
not as objectionable due to its great build quality (the others have sort of a ringing, hollow
sound, and it seems from reviews that the Matias is even louder in this respect.)

Once you decide to shell out for a Griffin iMate (I found a used one for $10 so it was easy
for me), the Apple Extended keyboard is a great choice for Mac users (PC users too, though
they can also pick up a Model M). I have not tried the Extended II, which I understand is
similar but not exactly the same.

(By the way, the new slim aluminum Apple keyboard is better than I thought it would be,
much better than the previous mushy white keyboard. But it’s still not a match for any of
these three keyboards if you like a clacky mechanical mechanism keyboard.)

—Steve

BusySync
After submitting the BusySync review, BusyMac released version 1.5 which, among other
things, includes syncing over the Internet in addition to via local network. It is worth
checking out.

—FEd Eubanks, Jr.

We'd love to hear your thoughts about our publication. We always welcome your comments, criticisms,
suggestions, and praise. Or, if you have an opinion or announcement about the Macintosh platform
in general, that's OK too. Send your e-mail to editor@atpm.com. All mail becomes the property of

ATPM and may be edited for publication.
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Bloggable

by Wes Meltzer, wmeltzer@atpm.com

Just Indulge Me

At the end of the year, when there’s not a lot to write about, many newspaper columnists
turn to the oldest trick in the book: running their favorite excerpts from a year’s worth of
columns. To these veteran journalists, for whom the column is a reward for many years of
daily beat-writing, it’s a good way to remind readers of their own words and a way to pad
out a slow news season. (Sometimes, they even punt on third down: the Miami Herald has
been running “classic” Dave Barry columns from my elementary school years on their Web
site. Oh, come on, guys.)

This isn’t a slow time of year for Mac news, but this magazine is stuffed full of everything
you need to know about this year’s Macworld San Francisco news: the MacBook Air. If
what you're interested in this month is the smallest mostly non-crippled laptop I've ever
seen advertised, and 2007 is already yesterday’s news, skip ahead; you won’t miss anything
Earth-shattering.

2007 was, in some ways, the best of years. As far as I'm aware, every single Macintosh
model was updated significantly, from the low-end Mac mini all the way to the awesomely
impressive eight-core Mac Pro. But I think 2007 can be summarized thusly:

Apple 5. ————— .
Dall s o Tt
Google 437 . —— B
HP 42— " i "
Microsoft =0 -‘——a_._'___,_._.—_,_ﬂw__.ﬂ_.-—- i
sony 4= r..__.-w.ﬁ-f'um____mhf_ y
Yahoo 3~ = " __ ---""Ffl"ma.__, =

Sparklines for major tech stock prices, 2007.

You wanna talk about a fantastic year to write about Apple? Believe it or not, I've been
writing this column for five years now, and I think this is the best year so far. There
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are a few reasons: the Macintosh and general technology blogs are maturing, and their
overall quality is better; OS X is better and Macs are more ubiquitous, which means more
meaningful discussions and less wailing and gnashing of teeth over missing or non-working
software features; and frankly, the environment is more favorable. But the biggest reason
of all has been Apple.

I mean, look at what’s happened in the last five years. The stock really takes off in 2004,
but the last year’s been stratospheric.

.—.—f“»"“""f&

Apple Stock Sparkline

This is an unbelievable change of direction for those of us who remember when being a Mac
user was one of those “weird” things that some people did, like being a vegetarian, that
were sometimes a source of pride and at other times a more ignominious trait. It was the
scarlet letter of the 1990s.

But what was this 20077

| Was Wrong

Basically, I blew the biggest story of 2007: the iPhone. You faithful readers may
remember that in January 2005, I mocked the entire idea that there would ever be
an Apple-branded phone. Oops?

In fact, in ATPM 11.01 I wrote, “[M]y bet instead is on a mid-range co-branded Motorola-
Apple GSM phone with flash RAM in it that can synchronize with selected iTunes playlists.”
I was right, for almost two years: the ROKR was exactly what I predicted, and even crappier
than I thought it would be. Has any phone ever been more of a dud than the ROKR?

That just about convinced me that we were not going to see an iPhone any time soon. Or,
really, any other forays into the mobile world.

So in January, Steve Jobs caught me flat-footed when he announced the iPhone. It turned
into the Device of the Year, and is so clearly superior to my Dell Axim PDA that I regret
buying it.

But that’s not all I got wrong, folks. I mean, isn’t my job to be wrong about 75 percent of
the time, and the rest of the time to let someone else be wrong for me?

Wrong—DRM story: In early April, Apple announced that it would sell music tracks from
EMI without digital rights management embedded, for $1.29 a track. It’s not quite what
the Cory Doctorows and Jon Lech Johansens of the world wanted, but it’s more than I
expected: I thought the letter was just to give Steve Jobs leverage in future negotiations.
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Wrong—ZFS: Apple is slowly preparing the world for the ZFS filesystem in OS X. The
Macintosh’s current filesystem, HFS+ and its predecessor HFS, has been with the Mac
since it was released—five months before I was born. Now, I'm going to give myself partial
credit here, because I was on the side of the people claiming that it would be an eventual
improvement. But it turns out there are a couple of things I botched, and one of them
was what ZFS could do for Apple. A reader wrote in to correct me: so far, ZFS does not
appear to be usable as a Time Machine target. And the column went to press before I could
ever use Time Machine, but now that I have, it’s not clear to me that ZFS’ live snapshot
functionality has much to do with Time Machine.

Wrong—Java 6 for Leopard: Apple does not appear to be any closer to releasing Java 6 for
Leopard than they were when I wrote about its absence. Now, we’ll come back to this in a
few months and see if there still isn’t one, but so far, it looks like I got this wrong, too.

| Was Right

Right—Amazon Kindle: I panned the Kindle in December, on the grounds that it wasn’t
very book-like for a book reader. I have not held one yet, although I'd still like to (is anyone
from Amazon listening?), but I have yet to read a review that makes me want a Kindle
since. The iPhone seems like a much more transformational device, at least so far.

Right—iPhone clones: The iPhone is the kind of transformational device, like the iPod or
iMac, which causes every tech manufacturer to try to emulate it rather than coming up
with their own good ideas. I predicted this, in February, at the same time that I owned up
to blowing the story overall. So far, we have three iPhone-alikes: (1) LG Voyager, which
at least mostly looks like an iPhone; (2) Sprint’s Touch, the only touch navigation-suited
clone, but also a wider, fatter device; and (3) the AT&T Tilt, which has a horizontal sliding
keyboard and enough hardware buttons to power the space shuttle. None of these devices
is all that exciting unless you're one of the gluttons who actually likes Windows Mobile.

Right—Third-party iPhone applications: So far there aren’t any. Apple’s splitting the
difference with its new Web Clips features, but I'm not really surprised that so far my pre-
diction that Apple was not going to create a parallel infrastructure to the Apple Developer
Connection just to support the iPhone—or that they’d take their sweet time supporting
those developers at all, if they ever did.

Right—Vista: Some analysts and tech writers, like the New York Times’ Randall Stross,
seemed to be under the impression that once Microsoft got the kinks in Vista ironed out,
they would be unstoppable. Apparently they missed the droves of people begging to con-
tinue buying new computers with Windows XP installed on them. My dad’s office made
the horrendous mistake of buying Vista, and I would just like to reiterate my position: I'd
rather have a root canal, but if I had to use Windows, I would use Windows 2000. Windows
XP was only “better” if you like pain, and Vista’s a special kind of gruesome.

Right—New iMac keyboards: Have you used these awful things? They’re horrible. I'm not
as picky as some people are about their keyboards, but I do like my keyboard to be usable.
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These new keyboards are no better than using the built-in keyboard on my MacBook, and
I find that my heavy-fingered typing style leaves my fingers and wrists sore after typing on
these new keyboards. No, thanks, Apple.

What a year that was. Can you forgive me for being wrong on the iPhone?

Now, on with the news!

The Cupertino Diet

This year I missed the MWSF keynote. I had to do this funny thing called “work”—the
kind that pays the bills. But one of my co-workers wasn’t quite as busy, to say the least,
and he sent me an e-mail saying, “You gotta check this out!”

The MacBook Air is so thin, so sleek and svelte, Tom Brady might break up with Gisele
Bundchen for it—after he wins the Super Bowl on Sunday. It’s not exactly Brett Favre,
apparently, with a slow hard drive and a customized low-clock-speed CPU. On the other
hand, it’s the first mass-market laptop which can use a fully solid state hard drive, although
it’s a $1,000 build-to-order option. (!)

Marco Arment, who works at Tumblr, notes that the solid-state option is probably going to
be unbelievably fast. But he’s right that the bottom line is that this is really only a good
secondary computer.

John Gruber was hoping it would be an ultra-portable revival of the old 12” PowerBook,
rather than a Kate Moss version of the widescreen 13.3” MacBook. He thinks, though, that
it’s positioned more toward the MacBook Pro end of the spectrum.

Slate’s Paul Boutin hits the nail on the head when he notes the MacBook Air’s biggest
limitation: it’s odd that a device that calls itself “Air” loses the connectivity edge to a phone,
but that’s what the tech world has come to. He thinks Apple should shove an EDGE radio,
at a bare minimum, inside the next generation MacBook Air. If it came with a $200
build-to-order option for EDGE access, or, better still, EV-DO, I’d buy one in a heartbeat.

Jason Snell of Macworld is impressed by the incredible number of things Apple had to get
just right to make the MacBook Air work. He notes that the power port is different, the
USB port is different, the LED backlight in the LCD is new, and the gesture support in the
trackpad is new. He sounds impressed, especially by the screen, and I'd like to pause for a
moment and imagine a world in which the short-life, slow-to-light fluorescent backlights of
LCD displays are gone soon.

The St. Paul Pioneer Press’ Julio Ojeda-Zapata is impressed by the amount of wireless
that Apple is pushing into its product line. WiFi for Internet, WiFi for optical drive access
and hard drive backups, WiFi for everything. If Apple could figure out how to power a
computer wirelessly, they probably would. Bring it on.

The Fishbowl, a.k.a. Charles Miller, remembers the tech pundits wailing when Apple took
away ADB, expansion slots, the 3.5-inch floppy drive, and countless other dead computer
parts. Is the MacBook Air the beginning of the end of the optical drive?
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Oh, and somebody at PC'" World thinks that the MacBook Air is the reason that Apple
should license OS X. I have no idea what this means. Mike Barton, the writer, says that
Apple won’t sell a sub-$1,000 laptop, and that only licensing the operating system would
do that. The flaw is that licensing OS X would probably kill Apple—its last attempt
almost did—and slaughter its one biggest advantage, the tight control over hardware and
the operating system that makes Macs work better than PCs. (Let’s pause for a moment:
even now that the parts inside your Mac are basically identical to a PC, doesn’t your Mac
still work better?) Dude, suck it up. Is $1,000 really too much to spend for a technology
writer?

In related news, the San Francisco Chronicle’s C.W. Nevius discovered that the Macintosh
has gone so mainstream that even its devotees aren’t that weird anymore. He’s right:
Leander Kahney told him, “The cult of Mac really isn’t a cult any more...The iPod and
the iPhone brought in lots of everyday people who were thinking about making the switch.”

Hunters and Gatherers

o NetNewsWire is now free, along with every other NewsGator product. I cannot believe
it, and neither could the boys at Rogue Amoeba. They're worried about what that
means for the rest of the paid RSS reader market, and for shareware in general. I'm
not so worried, because I hope it’ll help mainstream RSS, but I'm also not a shareware
developer.

« iCab is finally going to use OS X’s built-in WebKit HTML rendering engine. Smokey;,
of al-Qahira fi Amrika, observes that this is really quite an astonishing turn of events:
developer Alexander Clauss wrote the original iCab rendering engines all by himself,
and managed somehow to keep up with Firefox, Internet Explorer, and Safari—and
to do a better and more correct job rendering than they did. Whew.

o Steve Jobs is Money’s most powerful man in business. There’s no question he’s a
transformational figure, and I agree. At the same time, it’s a sign of the times that
Bill Gates has fallen to No. 7, behind Goldman Sachs’ CEO Lloyd Blankfein and

Google’s Eric Schmidt, Larry Page, and Sergei Brin.

o The New York Times Magazine’s Virginia Heffernan wrote a beautiful column about
how much she hates Microsoft Word. Steven Poole beat her to the punch, but Hef-
fernan is a very eloquent writer, and very convincing. Seriously, people: stop using
Word already!

o David Pogue discovered that Apple has quietly stopped imposing a numeric keypad
on its laptop keyboards. I'm not surprised—I've never once used this feature—but
it’s still a little odd.

And that’s a wrap for February! Have a wonderful month, everyone, and I'll see you in
time for spring break.
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MacMuser

by Mark Tennent, mtennent@atpm.com

One Click of My Finger

Long-time jaded Mac users must surely be astounded at the coverage this year’s Macworld
has generated and in particular the keynote speech. To those of us who’ve been Macced
up to the eyeballs since Clive Sinclair drove the C5 down the cul-de-sac of naff technology,
the keynote always hits a bum note. And that’s not counting the whoops from the idiots
in the audience, who insist on their stupid utterances like the ululations from professional
funeral wailers, every time Steve Jobs finishes a sentence.

These events are Apple’s way to screw dosh from punters for the latest must-haves conve-
niently on sale at the Apple Store as soon as the speech finishes. Payments go straight into
big bags saying SWAG on the side. Forget the pound/dollar conversion ratio, just swap
their symbols and keep the digits after.

Two Bucks to the Quid

With nearly two bucks to the quid, Apple kit is effectively more expensive than ever before.
The $229 Apple TV retails at £199 and not the £116 it ought to be. The MacBook Air at
$1,799 should sell at nine hundred quid and not the twelve hundred Apple charges. They
even don their stripey T-shirts and masks for shipping costs, which is free over $50 (£25.49)
in the Land of the Free, rather than the £78 minimum here on Treasure Island. As Jobs
said, with one click of his finger. . .he can take us for millions.

The new Time Capsule explains how Time Machine suddenly lost its ability to back up to
hard drives connected to Apple’s AirPort Extreme wireless router’s USB port. It was such
a good idea that Apple decided to make even more dosh by creating a whole new box of
tricks with the hard drive built in, but at the same time preventing us from buying our own
hard drives and connecting them to our existing wireless routers. Some believe Apple will
add this feature to the AirPort Extreme via a software update.

As it is, the Time Capsule is quite lust-worthy, but at what a price. With stand-alone
500GB drives at less than £100 and Time Capsule not having an ADSL modem built in,
it is as overpriced as the iPhone.

That Old System Is So Last Year

To make matters worse, the one big event many of us have been waiting for just didn’t
happen. Leopard is still in need of some serious under the hood tinkering, but the mechanics
at Apple seem to have spent more time playing iPhone apps to get their hands dirty with
last year’s operating system. As well as working out how to present a new thin laptop to
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the world at a ridiculously high price for its quite leisurely performing CPU. Especially
when it can only connect to the hard-wired world via micro-DVI, USB, or earphones.

But I want the new trackpad gestures, please.
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MacMuser

by Mark Tennent, mtennent@atpm.com

Transports of the Night

There are a hundred reasons to leave things alone when they work just fine. In the case of
telephone number inquiries, 118,118 reasons, to be exact.

This much-advertised service started in 2003 when someone persuaded the government it
was a good idea to bring competition into directory inquiry services. Where once we had
a three-digit number to remember, at a reasonable cost per call, now there are a bazillion
six-digit ones, each with a convoluted fee structure and, in personal experience, providing
a dreadful service.

On Yer Bike

It’s pretty much the same with the privatized UK public transport, which closed down over
Christmas, reducing us to a third-world country. The unions wanted to work, there were
no major engineering projects that needed roads and rail closed, and the public obviously
wanted some service, even a limited one. One union rep interviewed on the radio said that
a lot of public transport workers couldn’t even get to work to resume service because they,
too, relied on public transport. But the privatized road and rail companies refused to run
buses and trains despite the billions of pounds of subsidy they get from tax payers. To cap
it all, they raised their fares after Christmas to many times more than inflation.

Luckily, in the world of digital engineering, such close-downs are not a feature of the Christ-
mas holiday. We discovered that Leopard had broken our favorite TV streaming applica-
tion, CyTV. Worse still, the most recent message from its developer, Andreas Junghans, on
CyTV’s forum was in July when he said he didn’t have time to continue developing CyTV.

Victor Mature No Attraction

This would have been a sad day, because we find the cross-platform application CyTV an
excellent way of transporting live TV and EyeTV recordings around our palatial home,
office, and grounds. Summer time especially, for F1 races beside the bar-bee, but more
importantly, we’'ve just got off our backsides long enough to attach a laptop to our TV’s
HDMI port. Streaming video over an 802.11g network from the server to the laptop was
nearly but not quite fast enough. Over the Christmas period, the TV companies in the
UK excelled at providing exactly what we didn’t want to watch in the evening, running old
movies, circa 1950, at any time of the day or night. Selecting our son’s Slingbox connected
to cable TV showed the US was hit by a dearth of decent viewing. We had a choice of
hundreds of channels from the UK and US, all showing total dross.

We needed CyTV to access all our recordings.
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A quick e-mail to Andreas revealed the answer. He explained:

I'm currently in the process of rewriting the whole application. I hope to have
a first version ready in early January. The new version is written completely in
Objective-C and will be much simpler and more stable than the previous mix of
Python, AppleScript, and Objective-C. It should also be much easier to extend
and troubleshoot, and it will consume significantly less resources (especially
CPU).

The source is already open for anyone to pick up. The only thing that’s not
allowed is to commercialize it without releasing the source (GPL license). But
I think most people would have a hard time working with the source because of
the odd language/technology mix. However, the new version will have a very
simple structure that any Mac developer can easily understand and extend.

So that’s alright then. Although, as this issue of ATPM goes to press, the new version has
yet to materialize.
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Apple Talk

by Angus Wong, atkw@anguswong.net

Trade Show

The more things change, the more they stay the same. At Macworld Expo, the event that
the rest of the world calls the annual gathering for the Cult of the Mac, Steve Jobs unveils
what Apple has been hiding, and the world celebrates by drawing lines in the sand.

We’ve come a long way since January 7th, 1997, when Steve Jobs returned to Apple. Wall
Street commemorated the momentous occasion by closing AAPL at $4.375, down from
$4.4675 the day before. Obviously, the financial analysts weren’t impressed by this move.
Not very many of them were raising price targets like they have been doing in recent years.

Warp to January 15th, 2008. Steve Jobs announces, among other things, the MacBook
Air, Time Capsule, iTunes movie rentals, and added iPhone and iPod touch functionality.
AAPL closes at $169.04, down from $177.72 at the open. Certain media “pundits” complain
about “lackluster” announcements and the absence of iPod growth numbers. PC users slam
the MacBook Air, pointing to underpowered specifications.

So what else is new?

OK, so the current price of AAPL probably has more to do with the overall market malaise
concerning subprime mortgage issues and recession probabilities than any specific news item
from Steve Jobs’s keynote. But increasingly, a new digital divide is becoming apparent:
those who have a clue about Apple, and those who wannahave. Long-time Apple watchers
will understand when I say that Apple is not conducive to superficial analysis. It’s true
that you have to be somewhat of an “Apple follower” to keep track of the company, not so
much in the sense of blind-faith that the clueless keep accusing us of, but in the manner of
buying and using Apple products over the years, and observing how various personalities
and policies influence Apple’s direction at key turning points.

Because Apple is such a hot news item these days, lots of people are writing about the
company. It almost seems not to matter that the analysis is wrong, only that hot Apple-
related keywords are included so that the publications get reader traffic, and financial
analysts get paid for “saying stuff.” To be fair, there are also many good writers and
analysts out there, but for this month’s article I wanted to do a little exercise and see if
we can’t get away with being a clueless analyst. You can also try this at home with family
and friends. Let’s begin:

To start, I'm thinking we should completely dispense with what we honestly think. Since
the objective is just to spew out controversy and get read, it’s better to be all negative.
It’s easy to be negative. Like Sam Rayburn said, “Any jackass can kick a barn down, but
it takes a carpenter to build it.”
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So, here’s how I really feel:

o The MacBook Air could be the hottest computing item of 2008. So hot that, in fact, I
bought one (really!). I expect long wait times ahead in the next batch. The key thing
about an ultraportable is not so much its size but its weight (in my opinion). If I am
happy carrying around a small stack of paper (and I often do), then the MacBook Air
should be no problem. It’s not for Final Cut Studio. Just lightweight business and
daily tasks.

o iTunes movie rentals are the killer application for the Apple TV. This is so obvious I
feel embarrassed to even mention it. I expect Apple TV sales to start taking off now,
limited primarily by HDTV penetration but the prices of the latter consumer item
are coming down and becoming increasingly affordable. Decoupling Apple TV from
a Mac is genius. Think how many iPod owners use the device with a PC.

o Time Capsule is a great idea, but I need to be sure its wireless storage mechanism
is flawless before I give it five stars. It seems expensive, but actually pricing is very
good, considering everything you get with it.

e The iPod touch and the iPhone are set to keep morphing into the silver bullet gunning
RIM and Palm. RIM is really going to feel the heat and Palm is already as good as
dead.

And since we're going negative, we need to take these four points and turn them around,
even if we don’t actually believe any of the following crap that I just made up:

o The MacBook Air is a dead-on-arrival dud. Its screen is too large and the specs are
too wimpy. While Apple has been doing well in the higher-end notebook segments,
it is missing a great opportunity in the subnotebook segment. Executives will prefer
the ultraportable form factor of a smaller computer with the familiarity of Microsoft
Outlook on Windows.

o There is still no compelling story for the Apple TV. It remains an interesting Apple
experiment and won’t sell beyond a constrained group of early adopters who buy
anything with an Apple label on it. People who can’t wait to watch a movie will go
to the cinema. Those who want to watch it at home will buy it on the day of the
DVD release, not wait 30 days. Finally, those who are sufficiently savvy to hook up
and configure an Apple TV and muck around with digital video formats will just as
likely get their fix from BitTorrent and watch the show on their PC.

o Time Capsule is a solution looking for a problem. It is overpriced for what it offers.
Other vendors are giving the market much more affordable 802.11n gear, and very few
home users need gigabit Ethernet. If they are using “n” then why would they bother
with wired LAN? Wireless storage is also reported flaky and unreliable by users.
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o Apple’s upcoming SDK and the enhancements mentioned at Macworld for the iPhone
and iPod touch are gimmicky. The real market is the enterprise, and executives are
extremely happy with their BlackBerry devices. Microsoft will never make it easy for
Apple to connect to Exchange, which is the cornerstone of enterprise e-mail.

So, what do you think? Good enough? I hope I sounded fairly professional and critical.
It’s so easy to slam things.

Now, to wrap up the negative piece, we need to say something bad about Apple in general.
So we need to pick some low-hanging fruit. A cheap shot, if you will. How about sales
numbers? It’s always easy to go negative on sales numbers. Much harder to go out on a
limb and be bullish. So, just scramble together some more crap and we get the following:

« While the iPod has been a major (even primary) catalyst for Apple earnings growth, it
is becoming evident to this analyst/writer /blogger /paid shill that the market is at risk
of being saturated and growth acceleration is not likely to sustain. With unimpressive
product announcements from Macworld Expo, our/my/my dog’s near-term outlook
for Apple is unclear.

Translation: A lot of people have bought iPods (duh!). Saying something is “at risk” is
saying nothing (markets are always “at risk” of something), and besides, who really knows
what the saturation point is? We are not talking copper sulfate in chemistry class. And as
for outlook, we have no idea how these new products will do in the market (duh!).

So, whaddya think? Good enough to sound like we got a clue, when we actually don’t?

Copyright © 2008 Angus Wong. Angus is a long-time Apple user and technology business professional.
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About This Particular Outliner

by Ted Goranson, tgoranson@atpm.com

A Progress Report

It’s been some time since you have heard from ATPO, and I owe you a progress report. I'll
combine that with a few mostly unrelated, incidental observations.

A New QOutliner

If you've been reading ATPO in the past you might have noted confusing information at
the end of the column about my affiliation.

Here’s the skinny on that. I used to run research that looked at rather challenging problems
in what constitutes knowledge worth knowing, how we assemble it and make it live and
matter. A key piece of this is how humans interact with the machine. In an ideal solution,
the way humans think, the way the machine “thinks,” and the tricks the user interface
would use to cross that boundary would all be based on the same notions, both intuitive
and formal. That little statement hides many problems that will vex you if you let them
into your life.

They’ve been needling me for 40 years. Some time ago I retired because my lab became
politically driven. Many good people also left. In my retirement, those problems continued
to haunt me, even down to matters of setting up my own personal infrastructure. I have
some writing [ want to do, and although I've been a longtime user of Macs, I now had to
rely on commercially available tools.

ATPO began as a sort of open search for tools that I might use myself, using the insights
I’d gathered over the years about the very wonderful technique of mixed graphic and text
conventions that are the core of outlining. Much of what I know in this area is courtesy
of public funding, and I think best when presenting to an intelligent audience, so it made
sense to do ATPO the way I did.

In the last year and a half, I’ve gotten involved in some real, paying work again and
successively worked myself into a situation too sweet to not be thankful for. ATPO has
convinced me that although the set of tools we have now are robust and good, there really
isn’t one that does everything I want and can imagine wanting. In fact, though most of the
ATPO tools are great, there hasn’t been a significant advance in this area in ever so long.

It’s time for a major advance, and guess what? After daydreaming, designing, and propos-
ing, I am now actually building something. It’s risky, it’s ambitious, and there will be parts
we’ll have to adjust as we go. But I do think it’s a huge leap in the power of conceptual
tools for personal and collaborative use.
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I can’t say much at this point, but it is a media outliner, meaning you should be able to
outline within media. It’s Web-based. It does some things you’ve never seen before. We
hope to make it free. Stay tuned. You will hear it first in ATPO.

Our Writing Application Survey

It’s coming, but it will be much later than any of us would like. These things take a huge
amount of time. Be patient. I am using all the candidate applications somewhat and three
or four extensively.

Avenir has become StoryMill, and Storyist has appeared.

The Macworld Show

I got a lot of positive feedback on my report on the Worldwide Developer’s Con-
ference last summer. So I thought I'd give some remarks on the consumer version:
Macworld Conference and Expo, just held.

It was larger than any in the recent past. It may be my faulty memory, but I believe in the
OS 8 and 9 days these things were larger and more exciting. It was before the Internet was
such a force, and physical presence mattered more. New products really were announced
at the show and you could get very good deals. In fact, I would save money each year just
on that score.

The people used to be cooler, but then all people used to be cooler, and the Mac was the
platform of media creators rather than the dominant platform of media consumers. The
old shows used to be mostly software; now way more than half of the booths it seems were
either some hardware item or an “accessory.”

I saw nothing that amazed me, and that has never happened before. The coolest things
at the show were from Apple, and that’s not the way it’s supposed to be; big companies
don’t take the risks and explore the edges like the small, innovative guys do. I know of
a few way cool things that are around or in the pipeline, but they weren’t at the show.
When I complained about this to a friend, he asked me what I would consider “way cool,”
something that I couldn’t leave the booth without and show to my friends back home with
a swagger and flourish.

We came up with a couple of ideas, and one of them was so cool that I just couldn’t leave
the show without arranging to make it happen. This would be a small utility that will
do something obvious, cool and useful. It’ll be outliner specific at first, and cheap, with a
plug-in architecture.

So that’s the third promise I'm making as forthcoming offspring of the ATPO experience.
Software Costs

One of the things I'd like to do in a future column once I get things out of the way, is
to summarize the technical issues and then spend some time on the business issues. I've

ATPM 14.02 29 Outliners: A Progress Report


http://www.marinersoftware.com/sitepage.php?page=127
http://www.storyist.com/
http://www.atpm.com/13.07/atpo.shtml
http://www.macworldexpo.com/

become more and more aware that what we have in the creative tool space is not a well
functioning marketplace, and we are suffering because of it.

In a working market, people would innovate, prices would be determined by value, rewards
would flow, and consumers would get what they want. There would be a spectrum of things
out there ranging from solid to experimental, comprehensive suites to single utilities and
accommodating all sorts of tailored workstyles.

As it is, we have little innovation. Part of the problem, as I have maintained since the first
ATPO, is that outlining is a user convention and not a product category. But the problem
is not limited to outlining; I believe that much of the problem comes from the fact that
the pricing equation just doesn’t work. People aren’t willing to pay according to the value
received, simple as that. As far as I can tell, it’s purely historical. One of the reasons must
be the echoes of the dotcom boom that we are still living with. We seem to be getting a
lot for free or nearly so as companies build market share. Another reason must be that the
shareware of 10 or even 15 years ago had a sweet spot of 20 or 25 dollars, and that seems
to have stuck.

Four things have happened recently to make me aware of this. I've already mentioned
two: wonder about the lack of innovation, and thoughts about the value of the project I'm
working on.

We also had the experience of Mori.

Hog Bay NoteBook was one of the first products we surveyed. It got very high marks from
its users and always looked comparatively strong when we ran though a feature survey. At
some point its author decided that he could do even better and wrote the first outliner to
take advantage of technologies that first appeared in Tiger. This new outliner-notebook
was called Mori. Mori always looked extremely good here at ATPO because it supported
features that were rare. It also had a loyal base. Mori tried an innovative business model:
the developer put the users in charge of development with a fairly elaborate feature request
and voting system; he was extremely open, down to even reporting unit sales on his Web
site; and he gave away the core framework of Mori in expectations that it would spawn an
open source community.

This failed. Hog Bay Software is one man only, and he just could not make a living. He had
to go get a “real job,” working on Mori after hours. Eventually, he sold Mori to another
developer, Apokalypse Software, where it may thrive. Hog Bay Software now focuses on
simpler products, where the effort-to-cost ratio is more sustainable.

What went wrong? I think he charged too little, but perhaps he simply couldn’t overcome
expectations from the user community about what things are “worth.” It’s baffling to me.
Everyone in this community paid at least a thousand dollars for their Mac, likely twice
that. They pay a similar amount for their phone and Internet access. This is a community
where the biggest selling suites are $400 and $900.
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It is a community not anchored by children and gamers but by people who do real work and
who create real value with this category of software we're talking about. These products
make money and save time for their users, sometimes lots.

Well, around this time there was a discussion on a small Google group dedicated to Mac
PIMs. Now these things do tend to be dominated by blowhards and are probably not
representative of the user base. Or are they? A thread was started that seemed to suggest
that costs for something like Mori and the forthcoming Now Contact replacement should
be much lower than they are.

And people agreed!

I think we need three big things to keep the outliner-using application community strong.
We need better XML standards than OPML. We need a revolution in user interfaces, adding
more advanced outliner-specific capabilities. And now I add a third: we need a wider range
of workable business models.

We need to work on these things as a community.

Copyright © 2008 Ted Goranson, tgoranson@atpm.com. Ted Goranson is a senior researcher with Earl
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Research.
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Photoshop For the Curious

by Lee Bennett, Ibennett@atpm.com

Mask-erades

Welcome back to Photoshop For the Curious. Last November, when we briefly parted ways
to celebrate our various holidays, I shared the outcome of a splendid feature in Photoshop
that would be covered this month-—image masks. This month’s tutorial will explore the
basic steps of image masking. To the beginner, creating image masks can seem to be a
tedious and time-consuming task.

Admittedly, even to an expert, masking some images is laborious, depending on the shape
of the object to be isolated and how cluttered the background is. However, there are some
ways that can make parts of the process faster. I'll share some of these time-savers in this
tutorial, and show that the results of a good image mask are worth the effort.

So what, exactly, is an image mask? Examining the same graphic from last November’s
column reveals five elements composited into a single image.

A sample image that uses Photoshop’s image masking feature. (Artwork reproduced by permission of the
Forest Lake Seventh-day Adventist Church.)
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Each element began as a large, physical piece of artwork drawn by an artist. One by one, I
placed each piece against a white screen (the reason for the white screen will be explained
shortly) and photographed them.

Each individual piece of artwork was positioned on a pedestal against a large white screen to be photographed.
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This artwork was originally arranged on the stage at a church to illustrate a sermon series.
My task was to create a graphic image of the illustration that could be used in various
media, including being printed onto CDs, DVDs, and promotional flyers, as well as being
animated for video openers. When the art was arranged on the church stage, observers
could see the individual pieces in front of the chosen background. By photographing each
piece separately, I retained the ability to easily fine-tune the exact sizes and positions in
relation to each other.

At this point, in order to isolate the artwork and remove the unwanted background, someone
not familiar with image masks might say that I would just need to use the Eraser tool to
start removing everything that surrounded the art. This technique would work, but is
dangerous. If I erased a small portion and didn’t realize it, then came back at a later time,
the erased portion would be gone. But, with image masks, Photoshop always retains the
complete, original image. As the name suggests, unwanted parts of the image are simply
being masked, or hidden, from view.

There are probably countless ways the actual shape of a mask can be defined. However,
before masking can begin, the image must be on a non-background layer. For example,
if a plain JPEG image from a digital camera is opened in Photoshop, the Layers palette
will show it on a layer named “Background” in italics with a padlock icon to the right.
The default background layer does not support any type of transparency, so it must be
converted to an editable layer before it can be masked. This is most easily accomplished by
simply double-clicking that background layer. A New Layer setup window will appear with
several options that can be ignored for now. If a name for this layer other than “Layer 0”
is desired, the name can be typed in here.

From this point, the techniques are wide and varied. I will only be covering a very small
number of the possible techniques for creating a mask. All of the techniques are based on
two primary types of masks: Layer Masks and Vector Masks.

Vector Masks

Anyone not familiar with vector-based artwork can safely skip this Vector Masks section.
Those who use or create vector artwork will appreciate the ease with which a vector shape
can be used as a mask. To create a vector mask on the current layer, head to the Layer
> Vector Mask menu and choose Reveal All. Then use the Pen tool to create the vector
shape you want to use as the mask.
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Just like any other vector shape used in artwork, the control points can be relocated using the white Direct
Selection tool. Bezier handles can also be added to create curved lines.

Pixel-based Layer Masks

For my task of masking out the church artwork, a standard Layer Mask that does not
use vector shapes is more appropriate. I'm not looking to mask out hard lines. Rather, I
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want the mask to reveal only the artwork, following its edges to eliminate the background,
including the pedestal, and to even have soft anti-aliasing that will blend the edges into
any background.

Some designers will start by using the Pen tool, creating vector lines and curves to trace
around the artwork to be masked, and then converting the trace into an anti-aliased selection
which can then be made into a mask. Personally, I find this difficult and inaccurate,
especially in very small and tight portions of an image. So, I am going to show the method
of creating an image mask that I use most often, and ask that you remember that my way
s not the only way to do it. If you have skill in creating reasonably accurate traces using
vector drawing tools, there is nothing wrong with that method.

My first step is to go to the Layer > Layer Mask menu while the layer I want to work on is
active, then select Reveal All.
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Adding a Layer Mask to my image.

It may seem that nothing has happened, but looking at the Layers palette will reveal that
a white thumbnail has appeared on the artwork’s layer, next to its thumbnail. The white
thumbnail represents the mask layer and is the one I'll be working on from this point
forward.
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The newly created mask's thumbnail appears on the same layer as the artwork to which the mask was applied.
Currently, it is white, meaning that all of the original image is still visible. Black portions indicate areas that are
masked, or hidden.

While I'm talking about the Layers palette, look at the third button from the left along the
bottom—the one that looks like a gray square with a white circle. That’s a shortcut to the
Layer > Layer Mask > Reveal All command.

Also notice how the thumbnail for the mask has thin black lines on each corner. The
purpose of these lines is to indicate whether the image itself or its mask layer is targeted
for editing. It is easy to switch between editing the image and editing the mask simply by
clicking on the corresponding thumbnail.

With the mask layer active, I can now start hiding the parts of the image that I don’t want
to be visible. I said earlier that there was a good reason I placed the image in front of a
white screen. Having done so allows me to more easily select the background area with the
Magic Wand tool. A background of a single, flat color might have worked even better, but
the white projection screen was, at the time, the most readily available backdrop. Plus,
using white minimizes the risk of a thin halo of color appearing around the edge of the
completed mask.

In order to use the Magic Wand tool, I temporarily click on the image’s thumbnail so that
it is targeted and the Magic Wand “sees” the image’s pixels and not the pixels that make
up the mask. When I'm finished, I click on the mask’s thumbnail to continue editing the
mask.
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Using the Magic Wand tool with a tolerance of 10 and anti-aliasing enabled, | clicked to select the outer area
of the background, then Shift-clicked to select additional areas closer to the art, as well as isolated areas such as
between the boy's feet.

The dashed line (known as Marching Ants) visible in the above screenshot indicates the
area I have selected. Obviously, this wasn’t a perfect selection. An area on the girl’s arm
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wasn’t tight enough, and, because the Magic Wand tool was only selecting white areas, it
missed the pedestal and the thin black frame at the bottom of the screen. Fortunately,
these are all easy to fix once the mask has been established.

Remember, I'm going to be working on the mask layer and not the image itself. I confirm
this by noting the indicators on the corners of the mask’s thumbnail. Also remember that
white on a layer mask means that the image beneath is visible, and the entire mask layer
is currently white. Since black hides the image, I simply go to the Image > Adjustments
menu and select Invert. This command will only apply the inversion from white to black
in the areas defined by the selection I created.
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Having inverted portions of the mask layer from white to black, all areas of the mask that are black will make

the corresponding portions of the image transparent, as if | had erased those areas.

Photoshop For the Curious

41

ATPM 14.02



- X

| Layers > | Channels | Paths | 4

|. Normal == ]'DF'E'CiW:
o O8] o

= ;.'_1"'. I. Layer 0

A AR

Looking at the Layers palette, | see that part of the mask layer's thumbnail is black. The white area continues
to show the image of the boy and girl through the mask.

In the interest of completeness, I have described my technique of using the Magic Wand
tool for the benefit of anyone using older versions of Photoshop. In Photoshop CS3, there
is a new tool called Quick Selection (click and hold the Magic Wand tool to access it).
This tool accomplishes similar results somewhat more quickly and easily. With this tool’s
Auto-Enhance function enabled, the results might even be a little better. Some trial and
error may be required.

For images with surrounding backgrounds that are not as clean and solid as the white screen
I used for these pieces of artwork, the Magic Wand and Quick Selection tools may prove
to be ineffective. In such situations, the aforementioned practice of using the Pen tool to
trace the edges for a desired mask might be desirable. Alternatively, the Lasso tool can
be used to draw a selection fairly close to the desired edges, then cleaned up on the mask
layer. The same type of cleanup, albeit much less, is my next step on this sample image of
a boy and girl.

Fine-tuning the Mask

As previously noted, in addition to the pedestal, there are still a few small areas of the
background that need to be removed by expanding the mask to include those areas. In
order to more easily see where cleanup is needed, I generally create a new layer below this
masked layer, fill the new layer with either black or white, and periodically switch between
black and white to be certain I catch all areas that need cleaning up.
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With a black-filled layer behind my art, | can more easily see the areas that need to be cleaned up. At this
stage, always examine the image carefully. | found a tiny dot above/behind the girl's head, and | also noticed
some areas showing a thin white halo left over from the white screen that | had masked, such as along the back
edge of the boy's leg.

To finish masking my image, I check again to be sure the mask layer is targeted by clicking
on its thumbnail, then use the Brush tool to paint in additional areas I want to mask.
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I set the Brush size to only a few pixels, and normally use 90-100% hardness unless I
intentionally want to create a softer edge. I also make sure my foreground color is set to
black since black is the color that fully masks whatever is below. Likewise, the color can
be changed to white, causing the Brush tool to instead remove portions of the mask. This
becomes convenient if the original Magic Wand selection happened to include a portion of
the image that wasn’t supposed to be masked.

Filling in areas to be masked that were missed by my original selection. It may seem like I'm painting black on
top of my image, but | would need only to change that temporary black background layer to another color to
see that I'm really just hiding any area that | paint.

A larger brush allowed me to quickly wipe out the pedestal and the black screen border at
the bottom of the image. After I clean up all the edges, I can hide (or remove) the black
layer underneath the image, and my mask is completed.
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The completed mask.

Take note of the small chain link icon between the thumbnails of the image and the mask
in the Layers palette. That icon indicates that the mask layer is linked to the image layer.
When this link is enabled, any transformation I perform, such as moving or scaling, will
treat the image and its mask as a single object. Suppose, instead, I had a mask that was
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just a simple shape, like an oval, with a portrait inside. Then suppose I realized I'd like to
make the person’s portrait a bit larger in the space of the mask, but keep the mask exactly
the size it is. I simply click that little chain link icon to disable the link, target the image
by clicking on its thumbnail, then use the Transform tools in the Edit menu to enlarge the
image. Likewise, by enabling the mask’s thumbnail instead, the mask can be moved or
transformed while leaving the image in place.
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Adjustment Layers and Layer Styles also respect masks. Notice how the drop shadow is applied to the children,
ignoring the background which is still present, only hidden by the mask.

To finish my composite image, seen at the beginning of this tutorial, I repeated this process
for all the remaining pieces. Clearly, I had quite a lot more work to do on the field of hands
across the bottom and with the spokes of the wheelchair.
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Using the Refine Edge Feature
A new function in Photoshop CS3, combined with the Magnetic Lasso tool, may help in
creating a selection just prior to turning that selection into a mask.

Starting back at the original, unmasked image, I'll use the Magnetic Lasso to create a
selection. Note that I had originally used the Magic Wand to select the background, and
then inverted the color to black to mask it off. This time, I'm using the Magnetic Lasso to
create a selection around the children. The reason will be apparent in just a moment.
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Creating a selection around the children using the Magnetic Lasso tool.

Once I have my selection around the children, I went to the Refine Edge command under
the Select menu.
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Using Refine Edge to improve the selection.

(CS3’s Refine Edge window provides adjustments to tweak the selection and compensate for
less-than-perfect edges. As I adjust values such as the contrast between light and dark,
smoothness, and how much to feather (soften) the selection edges, I can toggle among five
different modes in order to preview exactly what the results will be.

The first mode shows the selection in the usual Marching Ants display. The second mode,
which is being used for the above screenshot, uses a translucent red color to show what
areas will be masked. The third and fourth modes place the masked portion above a black
background and white background, respectively. The fifth mode shows the mask itself.

Once I'm happy with the adjustments, I click the OK button and return to my image with
the Marching Ants having been adjusted per the Refine Edge changes. When I click the Add
Layer Mask button at the bottom of the Layers palette, all areas outside the selection are
hidden by the mask. Finally, I can target the mask by clicking its thumbnail and perform
further fine-tuning, as I described above.
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Homework Assignment

Try creating a crowd of clones! Take several digital shots of yourself (or of a willing vol-
unteer) standing in various poses. Open all the images in Photoshop and combine them
into a single Photoshop document with each image on its own layer. Hide all the layers
except one. Mask out the background so you're left with just the person. Hide this layer,
turn on another, and repeat until all the “clones” have been masked. Find a photo of an
environment in which the clones can stand. Place that photo behind all the other layers.
Unhide all the layers and use the Move tool to arrange each clone to the desired position.
Bonus points if one or more of the clones were sitting on something in the original shot that
is removed by the mask, leaving the clone to be sitting on something else that is visible in
the new background photo. Maybe you can even make one clone appear to be sitting on
another, who is on the ground on hands and knees.

ii—

rf 4.'-'

| created this image for the back of a CD case. Singers were photographed by themselves in a studio using a
plain background, which was hidden with a mask. The new background came from a stock photography library
and was placed behind the singers, whose positions were arranged to best blend with the alley. Finally, a
shadow of each singer was made to appear on the ground to approximate a light from overhead.
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Segments: Slices from the Macintosh Life

by Christopher Turner, cturner@atpm.com

Macworld 2008 Keynote Impressions

So the big news in the tech world last month was what Steve Jobs talked about during his
keynote address at Macworld Expo in San Francisco. The annual technology conference
geared toward the Mac OS, and all things Apple, Inc., is often used for the announcement
of new products from my favorite fruit company. Last month was no exception. Here are
some of my thoughts on what was announced:

Time Capsule

If T hadn’t bought an AirPort Extreme Base Station last year to replace a router that died,
I’d be buying a new 1 TB—yes, that’s a T, for terabyte—Time Capsule right now. Merging
an AirPort Extreme Base Station with a “server-grade” hard drive, the Time Capsule allows
for wireless backups from all of your Leopard-based Macs via Time Machine. Jobs called
it a “back-up appliance.”

=

Time Capsule

Backing up your data is very important, and too few people do it, realizing the value of
doing so only when it’s too late. Time Capsule is a dead-simple way, for most people, to
ensure their Macs are getting backed up. Plug in and power on the Time Capsule, open up
Time Machine on your Mac and point it to the Capsule, and you’re done.

Time Capsule comes in two sizes, with the 500 GB version weighing in at $299. That’s
approximately the same price as the AirPort Extreme, a nice 500 GB hard drive, and
a cheap USB enclosure. The aforementioned 1 TB version is $499. That’s an amazing
bargain, a terabyte of storage and a full wired/wireless router for five hundred smackers.
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As T said, if we didn’t already have the AEBS router, my credit card would have already
seen one of these charged to it.

iPhone Update

Tuesday, January 15th, the day of the Macworld Expo Keynote Address, was the 200th day
the iPhone had been available for purchase, and Apple’s sold 4 million of them, an average
of 20,000 iPhones sold per day. This means that in terms of United States smartphone
market share, Apple has nearly 20% of the national smartphone market.

The rumors of a 1.1.3 update to the iPhone proved to be true. The home screen can now be
customized, and the Maps application—the underrated killer feature of the iPhone in my
humble opinion—is now even more super-powered. The new Location feature in Maps is
great. Combining data from Google and Skyhook Wireless, your iPhone can now, without
GPS on board, triangulate your position within a couple of blocks. It pulled up my location
at home with no problem.

You can, finally, send an SMS message to more than one person, something my lowly
Motorola vb57 was capable of two years ago. The Web Clips functionality is pretty neat;
you can create a Web Clip from any Web page or portion of a Web page and pop it on to
your home screen, so it’s easy to just go to Google, or The New York Times, or whatever
Web page you wish, with one touch.

I had quite some fun that Tuesday afternoon playing with all of this new stuff, and it’s
almost like getting a new iPhone for free. All in all, it makes the iPhone an even better
communication device.

iTunes Movie Rentals

In addition to buying movies through the iTunes Store, you can now rent them as well.
Library movies (viz: older titles) are $2.99, and new releases are $3.99. From the time
you click “Rent Movie” in the iTunes Store and it downloads, you have 30 days to begin
watching the movie. From the time you click “Play” on the movie, you have 24 hours to
watch it. You can also transfer the movie to another device, such as your iPod or iPhone,
and watch it there as well, before your 24 hours or 30 days, depending on where you are
when you perform the transfer, are up.

The thirty-days requirement is pretty decent, but I find the 24 hours one to be a little
restrictive. It should be at least 48 hours, and 72 would be better, with 96 being the ideal.

Going hand-in-hand with the new rental service is an updated Apple TV, or as Jobs put
it, “Apple TV Take 2.” Whereas the original Apple TV pretty much required you to have
a computer to sync it up with, the new version acts as a stand-alone box. You can rent
movies from the iTunes Store in HD through the Apple TV, for only $1 more than the
standard resolutions. So library titles go to $3.99 and new releases are $4.99, and no trip
to the mailbox or corner Blockbuster is required.
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I'm still not convinced that we have a real use for this in our house, given our movie viewing
habits. For now, Netflix will continue to suffice, but I’ll be keeping my eyes on the Apple
TV, and I'm sure I'll try out the new rentals even without the new box.

MacBook Air

This had all the buzz, and was the announcement I was most looking forward to. I was ready
to pounce on ordering Apple’s new subnotebook, provided it met my personal expectations.

Apple has created the world’s thinnest notebook computer. At its thickest point, the
MacBook Air is 0.76 of an inch, and it weighs only three pounds. It comes with a full-size
keyboard, a 13.3-inch LED backlit display, and a 1.6 or 1.8 GHz Intel Core 2 Duo processor.
Two gigabytes of RAM, an 80 GB hard drive, 802.11n wireless networking, Bluetooth, and
a built-in iSight camera. A pricey option is to ditch the standard hard drive for a 64 GB
solid state drive (viz: no moving parts), and when I say pricey, I do mean pricey: $999 on
top of the base $1,799 cost.

You won’t find much in the way of ports on it, either: MagSafe power port, a single USB
port, headphone jack, and a micro-DVI port that requires adapters to hook up to external
displays. That’s it. The trackpad is larger than on previous MacBook versions, and features
multitouch, so you can perform some of those pinch and zoom gestures you may have seen
with the iPhone (plus some new ones).

MacBook Air

The downsides to this incredible piece of tech? For me, the hard drive size is the first.
I put a 160 GB drive in my four-year-old 12-inch PowerBook last year, and I've gotten
quite used to the extra room it gave me. I'd hate to step back down by half. Only two
gigabytes of RAM? And no way to upgrade it? My two-year-old iMac is maxed out at 2
GB, and sometimes I bump against that particular ceiling. I'd really prefer a machine that
can handle up to four. The battery is also not replaceable by the user. This might be OK
on an iPod or iPhone, but in a full-size computing system devoted to the ultimate road
warriors?

Ultimately, I decided this was not the next notebook computer for me. I was hoping for
the 12-inch PowerBook equivalent of the MacBook Pro, something with a smaller overall
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footprint, not just ultrathin and lighter, and the Air is clearly not that. It is its own unique
animal. It’s a really awesome system, and if someone were to buy one for me, I wouldn’t
hesitate to take it, but that’s not happening. I think I'll be better served ultimately by a
MacBook Pro, and with seven and a half months since the latest edition of those came out,
they’re due for a refresh, even a “silent” one like we saw with the Mac Pros just before the
Expo.

Summation

In the end, it was what I would call a typical Steve Jobs Macworld Expo keynote address.
There were the requisite ooohs and aaaahs, Apple making some evolutionary gains in all
facets of its business, and there was a great new product introduced that has the entire
tech world talking. It wasn’t a blow-me-away sort of keynote, as was last year’s with the
announcement of the iPhone, but then they can’t all be like that. Still better than anything
Bill does on stage.

Copyright © 2008 Christopher Turner, cturner@atpm.com. The Segments section is open to anyone.

If you have something interesting to say about life with your Mac, write us. Photos appear courtesy

of Apple.
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Desktop Pictures

by Kim Lee

Manado, Indonesia

We need new desktop pictures each month. Write to us!

This Month’s Desktop Pictures

This month’s pictures were taken by ATPM reader Kim Lee during a trip to Manado,
Indonesia in November 2007. They are of two resorts, Siladen and the Kima Bajo, which
lie in Bunaken National Park, a marine haven that is one of the world’s hotspots of marine
biodiversity.

View Pictures

Previous Months’ Desktop Pictures
Pictures from previous months are listed in the desktop pictures archives.

Downloading All the Pictures at Once
Some browsers can download an entire set of desktop pictures at once.

iCab Use the Download command to download “Get all files in same path.”
OmniWeb Choose “Save Linked > Images...” from the File menu.

Safari Use this Automator workflow.

Contributing Your Own Desktop Pictures

If you have a picture, whether a small series or just one fabulous or funny shot, feel free to
send it to editor@atpm.com and we’ll consider publishing it in next month’s issue. Have a
regular print but no scanner? Don’t worry. E-mail us, and we tell you where to send it so
we can scan it for you. Note that we cannot return the original print, so send us a copy.
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Placing Desktop Pictures

Mac OS X 10.3.x through 10.5.x

Choose “System Preferences...” from the Apple menu, click the “Desktop & Screen Saver”
button, then choose the Desktop tab. In the left-side menu, select the desktop pictures
folder you want to use.

You can also use the pictures with Mac OS X’s built-in screen saver. Select the Screen
Saver tab which is also in the “Desktop & Screen Saver” System Preferences pane. If you
put the ATPM pictures in your Pictures folder, click on the Pictures Folder in the list of
screen savers. Otherwise, click Choose Folder to tell the screen saver which pictures to use.

Mac OS X 10.1.x and 10.2.x
Choose “System Preferences. ..” from the Apple menu and click the Desktop button. With
the pop-up menu, select the desktop pictures folder you want to use.

You can also use the pictures with Mac OS X’s built-in screen saver. Choose “System
Preferences. ..” from the Apple menu. Click the Screen Saver (10.1.x) or Screen Effects
(10.2.x) button. Then click on Custom Slide Show in the list of screen savers. If you put
the ATPM pictures in your Pictures folder, you're all set. Otherwise, click Configure to tell
the screen saver which pictures to use.

Mac OS X 10.0.x

Switch to the Finder. Choose “Preferences...” from the “Finder” menu. Click on the
“Select Picture...” button on the right. In the Open Panel, select the desktop picture you
want to use. The panel defaults to your “/Library/Desktop Pictures folder. Close the
“Finder Preferences” window when you are done.

)
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Software Review

by Linus Ly, lly@atpm.com

Chameleon 5.0.881M Legacy

Developer: AKVIS, LLC

Price: $75

Requirements: Mac OS X 10.3.9, 512 MB of RAM, Photoshop 5. Universal.
Trial: Fully-featured (10 days).

GOOD
In my family, my second older sister is the traveler. She has visited many

US states and most countries in Europe, including some in the former Communist Bloc. She
has photos of herself in front of many famous places, like the Tower of Pisa and Stonehenge.
On the other hand, my travel is limited to a few big cities around the world. To have photos
of myself in front of many monuments, I would need to use software like Chameleon from
AKVIS.

Installation

Chameleon is a Photoshop plug-in, and as such installation varies slightly from the typical
process. After mounting the image, instead of copying the one file to anywhere in the hard
drive, the file has to be placed in the plug-in folder inside the Photoshop folder. There is
one version of Chameleon for Photoshop CS3 and above and another version for CS2 and
lower and Photoshop Elements. To use the program beyond its 10-day trial period, you
need to visit the AKVIS Web site to buy a serial number and enter it through the About
window.

Cut It Out

One popular use of Photoshop is copying a person from one photo into another. Select the
person from the first photo, copy the selection to the clipboard, then go to the second photo
and paste. Sounds easy, but the selection process can be daunting. There are a few ways
to select the person. There are also chapters in books that focus on the different selection
tools because selection is a skill to be acquired with practice.

My favorite selection tool is the magnetic lasso. As with the regular lasso, you can make a
free-form selection. The magnetic feature of the tool means that as you trace your person’s
outline, the line intelligently attaches it to the person based on color differences between
the person and the background. Still, with or without the magnetic lasso, making selections
is difficult. Usually, a selection must be made in multiple stages, adding with the Shift key
or subtracting with the Option key as you zoom in and out or move within the picture.

Blue Means Keep, Red Means Drop

With the Chameleon plug-in, transferring a cut-out of a person from one photo to another
is painlessly easy. I used Chameleon to transfer my son Justin from photo A to photo B.
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A: Justin making an impression of a monkey.
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B: The entrance to the Butterfly Valley in Hainan Island, China.

First, I roughly select the person with the rectangular marquee tool. Don’t worry that the
background is included, just be sure that the entire person is inside the marquee. Instead of
using the standard Photoshop Copy command, select Filter > AKVIS > Chameleon—Grab
Fragment. Chameleon acknowledges the action by displaying a window indicating that the
fragment was saved successfully. Next, go to the second photo and select Filter > AKVIS >
Chameleon—Make Collage.
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Select the person with the simplest tool.
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The following screenshot shows both the Chameleon user interface and what a fragment
looks like after it has been completely selected. The interface has few options so you don’t
get overwhelmed. As you pick the different buttons and menus, the online help in the lower
right corner is updated to tell you what the item does. In this case, I am in the Montage
mode to have Justin added to the picture with a sharp outline, rather than blend into the
surrounding. I already used the blue pen to roughly outline the parts that I wanted to keep.
I also used the red pen to, again, roughly determine the parts that I wanted to omit. Note
that the blue line is within the person’s outline. Similarly, the red line is slightly outside
of Justin’s shape. It is not necessary to draw either line close to the person, as that is
Chameleon’s job.
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Chameleon’s simple interface.

From faraway, the red and blue lines appear to be broken in places, but they are in fact
contiguous, as the close-up below shows. Well, at least the red line is contiguous, as I
purposely left a gap in the blue line, near Justin’s left shoulder. Drawing the lines was very
easy. | just draw a segment, zoom in or out as needed, and pick up again without having to
use any modifier keys. Chameleon did not try to help by completing any unfinished loops.
If I made a mistake, I would erase it with the eraser tool. Infinite undo and redo are just a
click away.
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Red means drop, blue means keep.

When I clicked the green “play” button in the upper right corner, Chameleon started
working on the image. The result is the picture above, which, at first glance, is not bad at
all. T did not exactly time the process, but I am sure it would have taken me much more
time had I tried the same thing with my trusty magnetic lasso. Chameleon was able to
work with the blue line even though I purposely left a gap in it.
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Not a bad collage. It certainly took me less time to make the collage.

Imperfections

While making the outlines, I thought the marble part of the statue behind Justin would
confuse Chameleon’s color computation. With Justin’s left hand covering part of the marble,
how would Chameleon tell where the skin ends? Surprisingly, perhaps because of the white
glow outlining the hand, that part of Justin came out fine in the collage. However, the gray
monkey statue behind his black hair did throw Chameleon off the track. Also, behind his
right arm the background is not so uniform, with green plants overlapping some brownish
steps.

The Chameleon demo video cleverly uses a model dressed completely in white and with
platinum blonde hair. Behind her is a wooden boat that is definitely not white. Similarly,
the photo-hunting tutorial in Chameleon’s PDF documentation has a boy squatting on
gravel with not much else in his background. These examples show that Chameleon works
best when the foreground object does not already blend in with the background.
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Background and foreground of similar color can fool Chameleon.

That is not to say that Chameleon cannot be tweaked to achieve a better outcome. I redrew
the blue and red lines around Justin’s head and right forearm closer to the border between
the foreground and background. The result is much better, although some undesirable
artifacts remain around the head.
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Fewer spiking hairs and a more natural right forearm.
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Some “hair” still spikes from the subject’s head.

The Downsides

The one and only bug I found with Chameleon is that every time I load a saved outline
fragment, the program crashes. This serious bug means that I must do all the work in one
sitting. Saving a fragment to continue the work later is useless because such saved fragment
cannot be loaded at all. I wrote to AKVIS and then sent them a copy of the saved fragments
that failed to load. I have been informed that AKVIS programmers will fix this bug in the
future.

Making collages with Chameleon is nice, but once you apply the effect, you end up with a
flat file. There is no layer to further manipulate. I am so used to Photoshop’s Layer feature
that I cannot help wishing that Chameleon would create a new layer as the final product.
I suppose you trade ease of use for limited power.

Besides the Montage mode, Chameleon has two more modes, Chameleon and Blend.
Whereas in Montage mode the fragment retains its sharp outline, in Chameleon mode
the fragment’s edge is softened to merge with the surrounding. The Blend mode takes it
further by blending the entire fragment into the background. I am not too impressed with
both modes, as what they do can also be done with Photoshop’s native Layer Opacity.
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The tutorials for these modes mention making use of the magic wand selection and other
seemingly advanced selection methods. They seem to contrast Montage mode’s dead-easy
rough-selection method.

Chameleon Mode
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Blend Mode

Verdict

At $75, AKVIS Chameleon is not cheap. It may be a fraction of the price of the full
Photoshop, but compared to Photoshop Elements it costs almost the same as the host
application. With Chameleon’s Montage mode, you can easily cut pieces of one photo and
make it look as if they belong in a second photo. Montage is not perfect and works best
when the foreground object stands out from the background, but it is still a big time saver
in many scenarios. I don’t find the Chameleon and Blend modes too impressive, but some
beginner Photoshop users may find them useful. If it were not for the issue with crashing
upon loading saved fragments, I would rate AKVIS Chameleon as Very Nice, but for now
the best it can garner is Good.

Copyright © 2008 Linus Ly, lly@atpm.com. Reviewing in ATPM is open to anyone. If you're interested,

write to us at reviews@atpm.com.
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Software Review

by Ellyn Ritterskamp, eritterskamp@atpm.com

Flip Words 2

Developer: Red Marble Games

Price: $20 (download); $25 (CD)
Requirements: Mac OS X 10.3.9. Universal.
Trial: Fully-featured (60 minutes).

YERY MICE

It has been awhile since I played a game that got me addicted immediately,

if you don’t count my first evening playing with a Wii. Even the basic games on that puppy
had me hooked. But that’s a different story. This story is about Flip Words 2, which had
me playing for an hour before I looked at the clock. This one is good.

The Red Marble Games Web site is easy to navigate. My download went without incident,
though it was kind of slow. Maybe my cable connection was to blame. Sometimes they
work on it late at night.

I launched the game, which was also a tad slow, but there was nothing to worry about. It’s
nice to take a breath every now and then.

The entry screen is pretty obvious, with a large Play button welcoming you. I started into
the Classic version.
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Here I'm in Round 12, with ten turns to solve the puzzle.

The point of the game is twofold: you want to make words by linking letters on the grid,
and when you do, you want the first letter of that word to reveal itself in the puzzle above.
So if you link the word cat in the grid, you’ll get all the Cs in the puzzle at the top. If
you've already solved a word starting with C, most of the time, you won’t want to waste
a turn on another one. The exception is if you have a word long enough to score bonuses,
which is anything five letters or more.

Hangman players know letter frequencies in English run something along these lines:
ETAOINRISHDLF

and choose their starting letters accordingly.

That’s the one I learned from a book published in the 1950s, so it’s probably shifted a bit,
but the general idea is the same. To succeed at Flip Words 2, you’ll need to start with
words beginning with some of these letters. It took me too long to figure this out, and I
ran out of turns in Classic version sooner than I should have. There are also gimmicks, but
they’re secondary to the word-making, which is why we’re here.
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| ran out of turns before | figured out the word eight, which | thought began with a consonant like L or R.

Now that I had the hang of it, I started the Strategy version. It’s essentially the same game,
but you earn tokens instead of using turns. You may use your tokens to purchase vowels
or to have the game show you the longest word on the grid. Now that I knew how to play
the game, I could not use the tokens as fast as I earned them (you receive bonus tokens
when you solve the puzzle, based on the number of letters left uncovered). I finally had to
just quit, though the game saved my information, so I can start there next time, with the
tokens already built up.
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| raked in lots of tokens for solving this puzzle early.

I moved on to the Party version, which is online. In this one, groups of people solve a
puzzle by making word chains. There is no “solving early.” I wanted to like it, but I didn’t.
I don’t know if my opponent was a real person because the chat section only allowed us
to use prewritten comments such as “Way to go!” and “Bummer.” We couldn’t type real

questions. Also, his name was pretty generic, so I thought maybe he was a bot.

This part could be interesting if you played competitively, or played with friends. But the
game is essentially designed for solo work, I think, so it seemed a little contrived to try to
play it as a team. But that might just be me.

Other online features include high-score tables, and you can also submit puzzles for other
players. My game downloaded a couple of dozen each time I got online.

The Bottom Line

I liked this game very much. I am a fan of word games, so this is high praise. I will have
to be careful not to play it too often, though. It’s addictive. I look forward to all those
way-challenging puzzles everyone is writing for us!
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Accessory Review

by Chris Lawson, http://chrislawson.net

Kinetik 15.4 Backpack

Developer: Logitech

Price: $100

Requirements: 15" (or smaller) notebook.
Trial: None.

YERY MICE

Logitech has jumped into the laptop backpack market with the Kinetik
15.4, a semi-hard-shell backpack designed to carry a 15” (or smaller) laptop and provide a
reasonable degree of protection.

For someone who follows the market—and there are probably no more than five of us—the
Kinetik appears at first glance to be a slightly scaled-down version of the Axio Hybrid.
Closer inspection reveals that the Kinetik is not only similar to the Hybrid, but that it’s a
Logitech-branded Axio design.

The biggest difference between the Kinetik and the Axio Hybrid is size. The Kinetik
is designed for a maximum laptop screen size of about 15 inches, while the Hybrid can
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swallow up to a 17" laptop. Those of you with laptops larger than the 15” MacBook Pros
will want to look elsewhere.

Like most other backpacks these days, the Kinetik fairly bristles with zippers. There’s a
zippered pocket in the top of the pack, one in the left side that sits between the back pad
and the pack itself, and even one in the right shoulder strap. Both shoulder straps are
padded and contoured for comfort, and an integral chest strap makes sure the pack won’t

go anywhere.
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Strap Pocket

I'm unconvinced of the utility of the strap pocket and the back pocket, as anything thicker
than an iPhone in the back pocket would be an annoyance, and the strap pocket struggles
to hold anything larger than a couple of business cards. The internal nooks and crannies,
however, are a different story.
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Secondary Pocket

The secondary compartment is quite roomy and very well designed, with several pockets
for batteries, iPods, writing utensils, and books. Though the Kinetik is noticeably smaller
from the outside than the Hybrid—about the same size as the two Axio hard-shells—it
is substantially roomier inside than either of the hard-shell packs from Axio or Boblbee’s
Megalopolis. The Kinetik’s superior layout allows you to carry nearly as much stuff, if not
more, than Axio’s Hybrid.
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The Kinetik seems to provide at least as much protection as the Hybrid does, though the
Kinetik does not ship with its own sleeve. It does have a nicely padded integral “sleeve” of
sorts, though one end of the laptop will be exposed to whatever else is in the backpack. The
laptop compartment is roomy enough to accommodate a fairly thick laptop, so if you're
looking for maximal protection, you could put your PowerBook in a Brain Cell or MaxSleeve
without any problems.
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The semi-hard-shell exterior also provides a degree of weather protection, on par with that
of the Hybrid and vastly superior to that provided by any standard nylon day pack. As
I have previously suggested, if you plan to use the Kinetik in the rain, make sure you
don’t match up the double zippers at the top of the pack where possible, as that’s an easy
place for water to leak in. Of note is the Kinetik’s lack of a headphone cable pass-through,
previously a prime entry point for water on similar packs.
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Looking back to the previous backpack reviews I've done, the Kinetik addresses almost all
the major complaints. The Hybrid is really too big for its own good, though it’s the only
option for 17” laptop owners. The hard-shell packs are all great for protection but leave a
lot to be desired in terms of internal storage space, making it difficult to carry more than
a laptop, power adapter, spare battery, and maybe one book. Like Goldilocks’s assessment
of Baby Bear’s bed, chair, and porridge, I think a lot of Mac laptop owners will find the
Kinetik to be Just Right.

Copyright © 2008 Chris Lawson, http://chrislawson.net. Reviewing in ATPM is open to anyone. If
you're interested, write to us at reviews@atpm.com.
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Software Review

by Ed Eubanks, Jr.

MacPinball 2.6

Developer: baKno
Price: $20 (single-user); $30 (two licenses)
Requirements: Mac OS X 10.2.8. Universal.

Trial: Fully-featured (15 days).
GOOD

When I was in high school, a buddy and I hit the arcade regularly. While

I played a variety of games, when I was with Robert we always played pinball. There was
a nostalgic warmth to pinball machines, and I loved how the better machines represented
a challenge at multiple levels. Robert was especially adept, and he could frequently count
on earning himself a free game.

I have fond memories of playing pinball in the arcade—standing before a familiar structure,
middle fingers on the flipper buttons, a Coke resting atop the glass. In the home movie of
my mind, Robert watches on from one side of the machine, and perhaps his girlfriend or
mine is at the other side. We would take turns, flipping, nudging, and laughing for hours.

Fast-forward 20 years, and now I can play pinball on my Mac, thanks to baKno’s MacPin-
ball. I played pinball on a Windows PC before, and never found it to be very fulfilling. So
I tried out MacPinball for a few evenings to see how close it came to my fun memories of
high school arcade runs.

Basic Overview

MacPinball opens to present a basic set of instructions for which keys operate the different
functions—Ileft and right flippers (or “bars” in MacPinball terms), the shooter, and—as a
very nice touch—even a nudge is provided. From there, all you have to do is start playing.
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The gameplay is a good approximation of real play, allowing many of the same tricks as a
live machine might offer. You can trap the ball with the flippers, for example, just like in a
real pinball machine. You don’t have to wait for the ball to drop in to pull back the shooter.
Sound effects are good, not too annoying, and also fairly approximate a real machine. I can
tell that the developers have actually played pinball before, and enough to appreciate the
nuances.

Three different “machines” allow variety for gameplay. One has a series of chutes and
ramps, with a magnetic spinner; another has chutes, tunnels, a spinner, and more bumpers
than the first; the third has a double set of flippers, ramps, a spinner, and a big tunnel.
Each machine has a different table-top too, and very different looks. And each supposedly
emulates a different ball—plastic, wood, or metal—for further variation. All three are about
the same difficulty level, however.
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An option for two-player mode offers competitive play. I haven’t had an opportunity to
try this out; my wife isn’t much of a gamer! But apart from two sets of balls, there is
apparently very little difference otherwise.

Though the settings are sparse, they are useful. You may choose from a handful of camera
angles, largely designed to enhance the realism of the gameplay. You can also choose to
use a faster ball—which is, I'm guessing, intended to represent a higher level of difficulty.
Frankly, I didn’t notice a substantial change here, and I ended up leaving this setting on
for the whole time I played. Window size and turning sound effects off and on round out
the settings.
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Problems

Finding how to switch from one “machine” to another was tricky and required probing until
I found it. T’ll let you in on the secret: it’s in the different ball types. Each of the three balls
is directly tied to a different machine. In other words, you can’t play the same machine
with three different ball types. This might be a fun switch, particularly if there are actually
variations in the way they emulate the ball action. (This matters in real-life play; a metal
ball is heavier and hard, while the plastic ball is hard but lighter, and a wooden ball has
the weight but is softer with a bit more give.)

MacPinball is written to run on the multi-platform Mono environment (somewhat like Java,
from what I gather). Thus, though MacPinball is a “Mac-only” game according to baKno,
there doesn’t seem to be any reason why it would be difficult to port it to other platforms.
The bare-bones interface (due to the Mono setup) gives the game a less-than fully Mac-like
experience. This isn’t a problem for playing the game, but users looking for a true Mac
game might frown.
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Concluding Thoughts

Somehow, the experience of Pinball doesn’t translate into a computer game like I want it
to. I suppose it is sort of like playing poker or blackjack through one of the many locally-
installed card games—the lack of investment (in the case of pinball, hard-earned quarters!)
makes the experience less fulfilling. MacPinball does a good job of bringing the game-play
part to my Mac, but the joy of the whole experience is lessened.

Still, MacPinball is, overall, a good pinball game, as computer games go. It does a fine job
of emulating the essence of the pinball experience, as much as one can expect it to do so
on a laptop or desktop computer.
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FAQ: Frequently Asked Questions

What Is ATPM?

About This Particular Macintosh (ATPM) is, among other things, a monthly Internet mag-
azine or “e-zine.” ATPM was created to celebrate the personal computing experience. For
us this means the most personal of all personal computers—the Apple Macintosh. About
This Particular Macintosh is intended to be about your Macintosh, our Macintoshes, and
the creative, personal ideas and experiences of everyone who uses a Mac. We hope that we
will continue to be faithful to our mission.

Are You Looking for New Staff Members?

ATPM is looking to add more regular reviewers to our staff. Though all positions with About
This Particular Macintosh are volunteer, reviewing is a great way to share your product
knowledge and experience with fellow members of the Macintosh community. If you're
interested, contact ATPM’s Reviews Editor, Paul Fatula.

How Can | Subscribe to ATPM?
Visit the subscriptions page.

Which Format Is Best for Me?

e The Online Webzine edition is for people who want to view ATPM in their Web
browser, while connected to the Internet. It provides sharp text, lots of navigation
options, and live links to ATPM back issues and other Web pages.

e The Offline Webzine is an HT'ML version of ATPM that is formatted for viewing
offline and made available in a Mac OS X disk image. The graphics, content, and
navigation elements are the same as with the Online Webzine, but you can view it
without being connected to the Internet. It requires a Web browser.

o The Print PDF edition is saved in Adobe PDF format. It has a two-column layout
with smaller text and higher-resolution graphics that are optimized for printing. It
may be viewed online in a browser, or downloaded and viewed in Apple’s Preview or
Adobe Reader on Macintosh or Windows. PDFs may be magnified to any size and
searched with ease.

o The Screen PDF edition is also saved in Adobe PDF format. It’s a one-column
layout with larger text that’s optimized for reading on-screen.

How Can | Submit Cover Art?

We enjoy the opportunity to display new, original cover art every month. We're also very
proud of the people who have come forward to offer us cover art for each issue. If you're a
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Macintosh artist and interested in preparing a cover for ATPM, please e-mail us. The way
the process works is pretty simple. As soon as we have a topic or theme for the upcoming
issue we let you know about it. Then, it’s up to you. We do not pay for cover art but
we are an international publication with a broad readership and we give appropriate credit
alongside your work. There’s space for an e-mail address and a Web page URL, too. Write
to editor@atpm.com for more information.

How Can | Send a Letter to the Editor?

Got a comment about an article that you read in ATPM? Is there something you’d like
us to write about in a future issue? We’d love to hear from you. Send your e-mail to
editor@atpm.com. We often publish the e-mail that comes our way.

How Can | Contribute to ATPM?

There are several sections of ATPM to which readers frequently contribute:

Segments: Slices from the Macintosh Life

This is one of our most successful spaces and one of our favorite places. We think of
it as kind of the ATPM “guest room.” This is where we will publish that sentimental
Macintosh story that you promised yourself you would one day write. It’s that special place
in ATPM that’s specifically designated for your stories. We’d really like to hear from you.
Several Segments contributors have gone on to become ATPM columnists. Send your stuff
to editor@atpm.com.

Hardware and Software Reviews

ATPM publishes hardware and software reviews. However, we do things in a rather unique
way. Techno-jargon can be useful to engineers but is not always a help to most Mac users.
We like reviews that inform our readers about how a particular piece of hardware or software
will help their Macintosh lives. We want them to know what works, how it may help them
in their work, and how strongly we recommend it. Please contact our reviews editor, before
you begin writing, if you have a piece of hardware or software that you’d like to review.

Which Products Have You Reviewed?

Check our reviews index for the complete list.

What is Your Rating Scale?

ATPM uses the following ratings (in order from best to worst): Excellent, Very Nice, Good,
Okay, Rotten. Products rated Good or better are ones that we recommend. Okay products
get the job done. We recommend avoiding Rotten products.

Will You Review My Product?

If you or your company has a product that you’d like to see reviewed, send a copy
our way. We're always looking for interesting pieces of software to try out. Con-
tact reviews@atpm.com for shipping information. You can send press releases to
news@atpm.com.

ATPM 14.02 89 FAQ


mailto:editor@atpm.com
mailto:editor@atpm.com
mailto:editor@atpm.com
mailto:reviews@atpm.com
http://www.atpm.com/reviews/
mailto:reviews@atpm.com
mailto:news@atpm.com

Where Can | Find Back Issues of ATPM?

Back issues of ATPM, dating since April 1995, are available in DOCMaker stand-alone
format and as PDF. In addition, all issues since ATPM 2.05 (May 1996) are available in
HTML format.

What If My Question Isn’t Answered Above?

We hope by now that you've found what you’re looking for (We can’t imagine there’s
something else about ATPM that you’d like to know.). But just in case you've read this
far (We appreciate your tenacity.) and still haven’t found that little piece of information
about ATPM that you came here to find, please feel free to e-mail us at (You guessed it.)
editor@atpm.com.
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